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Microsoft Word

Let’'s download Microsoft Word
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Microsoft Word is a program that lets you create documents, and write and edit
texts like letters, articles, or assignments.

If you don't already have Microsoft Word on your computer, you can visit the
Microsoft Office website to buy a subscription and download it on your computer.

To download it, either click this link or open up your internet browser and search
for Microsoft Word. Then click on the first result, Word Processing Software |
Microsoft 365.

Go g|e microsoft word X

Q Al @ Shopping [ Images B News [J Videos i More

About 1,360,000,000 results (0.62 seconds)

https://www.microsoft.com > en-us > word

Word Processing Software | Microsoft 365

Microsoft Word - Get the Word mobile app - Transform documents to web pages - Get real time

translation with just a click - Add more dimension to your docs - Review ...
Word - Word 2013 - Word 2007 - Word 2010

Click on the Try 1 month free button. You'll need to type in your credit card
information. Microsoft will charge your credit card yearly for the subscription.
Then, you'll be able to install Microsoft Word on your computer.

Try Microsoft 365 for
free

Get a free trial and you'll have access to the latest Al-powered apps, 1 TB of
cloud storage per person, and premium mobile features to stay on top of
things wherever you are on any device.

Try 1 month free Ready to buy Microsoft 365?

After your 1-month free trial, Microsoft 365 Family is CAD $109.00 per year. Credit card

required. Cancel anytime to stop future charges.”



https://www.microsoft.com/en-ca/microsoft-365/word

Microsoft Word

Open Word

r

If you're using a Windows computer, there are
two ways to open Word.

You can:

1. Click the Start button 6 Then scroll down
and click Word. e

2. Click the Start button 6 Type “Word" in Microsoft Edge
the search box and press Enter.

Partly Cloudy

49°

Washington....

If you're using a Mac, you can
click on the Microsoft Word icon
on the Dock, located at the
bottom of your screen.
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To create a new document,
click File in the top left
corner. Then double click
Blank document.

Insert  Design

New

Ok Search for online templates

Save Suggested searches: Business Cards Flyer

Save As

Save as Adobe
PDF

Print

Share

Export

Blank document
Close




Microsoft Word
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The blinking line you'll see in the document is called the

cursor |. The cursor shows you where you'll start typing.
You can click somewhere else in the document to move
your cursor there.

1. Type “The weather outside is sunny.” and press Enter.
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2. Type “Yesterday it was raining.” and press Enter.
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3. Type “Tomorrow will be cloudy.”

The weather outside is sunny.
Yesterday it was raining.
Tomorrow will be cloudy.

Selecting text

(A

can change things like the size,

fter you've typed something, you \
colour, or style of the words. First,
you'll need to select and highlight
the text.

Move your cursor to the beginning

of the first line. Click and hold the
left button on your mouse and drag The weather outside is sunny.

Yesterday it was raining.

your cursor to the end of the Tomorrow will be cloudy.

sentence. Then let go of the mouse
button. You'll see the entire line is
now highlighted in blue. Now you

\can change the text you selected. /
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Bold, italicize, and underline
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You can make some text stand out by
changing its style:

¢ Bold makes the letters thicker and darker
¢ |talics means the letters lean to the right

¢ Underline puts a line under the words

To bold the line you selected, click the Bold
icon B .

The weather outside is sunny.
Yesterday it was raining.
Tomorrow will be cloudy.

The weather outside is sunny.
Yesterday it was raining.
Tomorrow will be cloudy.

The weather outside is sunny.
Yesterday it was raining.
Tomorrow will be cloudy.

The weather outside is sunny.
Yesterday it was ra.l'm'ng.]
Tomorrow will be cloudy.

Select the second line.

To italicize it, click the
Italics icon I .
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Microsoft Word

Select the third line.

To underline it, click the
underline icon U .

The weather outside is sunny.
Yesterday it was raining.

Tomorrow will be cloudy.

The weather outside is sunny.
Yesterday it was raining.
Tomorrow will be cloudy.

Changing the font
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Termpus Sans 1TC by lad]

Times New Roman
TitilliumMaps26L
TRAJAN PRO
Trebuchet MS

Tw Cen MT

Tw Cen MT Condensed

You can also change the font of the text you
selected. The font is the look of the words on the
screen. In Word 2016, a new document always
starts with a font called “Calibri,” but you can
change it. Your version of Word might start with
a different font.

Select the first line. Then move your mouse up to
the toolbar and click on the arrow next to Calibri
(Body) or your version’s starting font.

A list with many font options will appear. Click on
Times New Roman.
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The weather outside is sunny.
Yesterday It was raining. The font of the first line (
Tomorrow will be cloudy. .

will change. If you type
more words on this line
after this sentence, they
will also appear in the
new font.

Changing the font size

The weather outside is sunny.

Yesterday it was raining.

Tomorrow will be cloudy. Select the second
line you typed.

You can change the
size of the font, too.

Calibri (Bo... vA* A’
5
B I U v v
U~va o | A
6.5
75
8
9
Th th L
€ weather nny.
Yesterday it v 105 ([
Tomorrow wi ‘/1"2 A new document usually starts
/ with the font size set to 11 or 12.
Move your mouse to the toolbar
20 and click on the arrow next to the
22 font size. Then choose a new
number.
Try changing the font size to 16.
J
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Calibri(Bo.. v 16 ~ A" A Aav A

B I Uva x, X Av v A

TN
The bigger the

number, the bigger
your font will be.

The weather outside is sunny.

Yesterday it was raining.
Tomorrow will be cloudy.

A new document always starts

Changing the font colour
with the font colour set to black.
< To change the colour of the font,

click on the arrow next to the font
colour A v and choose a new
colour.

Select the third line. Try changing
the font colour to orange.

Then, change the first line to

o — | green.
s B I x A o[ES] P
A . | [ W [
I | | . o
i The weather outside is sunny.
The weather ol I Ill I Yesterday it was raining.
Yesterday it Tomorrow will be cloudy.
Tomorrow will| Standard Colors
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Microsoft Word

Highlight text

You can highlight parts of the text using the
highlight tool # ~ .

Select the second line.

Click the arrow beside the highlight button,
and choose a colour from the drop-down
menu. Let’s pick yellow. Now your text is
highlighted in yellow.
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The weather outside is sunny.
Yesterday it was raining.

Tomorrow will be cloudy.

Create a bulleted list
~

You can organize things into a list
using bullets.

Select all three lines of text. Then, > J
click on the arrow next to the
Bullets icon := v .

\

Different bullet options will appear.
Choose the style of bullets you'd
like to use.

- )

Document1

References Mailf¥s Review View

A= W = ==

Define New Bullet...

RCN

e The weather outside is sunny.

e Yesterday it was raining.
o Tomorrow will be cloudy.
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Create a numbered list

/You can also create lists using numbers or letters. \
Select all three lines of text. Then, click on the arrow
< next to the Numbered Bullets icon := ~.

Choose which style of numbers or letters to use for
your list.

J
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None 1. The weather outside is sunny.
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M 2. Yesterday it was raining.
3. Tomorrow will be cloudy.

m
o
—

. C. ¢)

Undo and redo text
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If you make a mistake when you type, or if you accidentally delete
something, you can fix it by using the undo and redo buttons.

You can undo a mistake by clicking the undo button at the
top left of Microsoft Word. It'll reverse what you just did.

It repeats something that you undid.

AN

You can also redo the change by clicking on the redo button .

Try undoing everything until
you have a blank page and
there is no text on the screen.

10
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A hyperlink is special text you can click on to open a

website. Hyperlinks usually look like this.

Add a hyperlink

Let's add a hyperlink.

Type this sentence: “Here is a link you can use to
find today’s weather.” Then, select the word “link”.

J

Here is a link you can use to find today's weather.

Right click on the word “link” and select Hyperlink.
e is a lir X cut

If you're using a Mac and don't have a right click
By Copy

button on your mouse or touchpad, you can open the N ‘
. . . [ Paste Options:
right click menu by holding Control | contror | ON your =

keyboard and clicking on the word “link”. ) A Eo?t___

=q Paragraph...
SO Smart Lookup
Synonyms 4

E‘% Translate

% Hyperlink...

'L':J New Comment

Address: http://www.weather.com e

In the pop-up box, type www.weather.com in
oK the Address bar. Then click OK.

In your document, the word “link” will turn
blue and become a hyperlink. Hold Control  Ctrl

vi1i2 v A A Ay A

%
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Mac keyboard, and click on the hyperlink. Your
internet browser will open and go to
www.weather.com.

Hereisa MIvou can use to find today’s weather.

To remove a hyperlink, right click on the
word “link” and click Remove Hyperlink.

on a Windows keyboard, or Command Hlona

11
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Check spelling and grammar

4 )

When you're done writing your text, it's a good
idea to check the spelling and grammar.

Click on the Review tab, and then click on
Spelling & Grammar.

\_

{d O

Home Insert Design Layout References Mailings ew
ABC ABC N D +
VYRIEE 3 O ap ®F 02 )
Spelling & Fhesaurus Wmd Smart | Translate Language New  Delete Previous Next Show
Grammar Count Lookup - - Comment Comments
Insights Language Comments

Microsoft Word will mark places you should check with a

red wavy line. In a box on the right, Word will suggest

changes that you can choose to ignore by clicking the
\Ignore button, or accept by clicking the Change button.

L-‘g‘-‘|‘-‘1‘-‘|‘-‘2‘-‘|‘-‘3‘-‘|‘-‘4‘-‘|---5-‘- Gé

elling T
weaher

lgnore | Ignore All | | Add

weather
Here is a link you can use to find today’s weaher. e
. weaker
wearer

weaner

Change J§ | Change All

1
I

If there are no suggested changes, you'll see a pop-up
box that says “Spelling and grammar check is complete.”

<

Microsoft Word X

o Spelling and grammar check is complete.

12
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Add comments

Ve

Anyone can add comments to a Word document. This is helpful if you or

someone else wants to add feedback or notes.

On a new ling, type in “Today I'm learning Microsoft Word.” Then, select the

word “Today.”

Click on the Review tab, and then click New Comment.

L

References Mailings
-
th [
Comment

Comments

Here is a link you can use to find today’s weather.

Stevens, Jeff
What will I learn tomorrow?

[Today |'m learning Microsoft Word.

7

A space will appear on the right for you to add your comment or suggestion.

In the comment box, type “What will | learn tomorrow?”
To save your comment, click anywhere else in the document.

To delete a comment, right click on the comment and click Delete Comment.

If you're using a Mac, you can open the right click menu by holding Control

on your keyboard and clicking on the comment.

control

13
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Add a table

| Design Layout References Mailing

s || PR =l

Table Rictures Online Shapes SmartArt Chart ¢
v Pictures

Insert Table

A table is a grid of boxes organized ol
in columns and rows where you '
can enter data. Tables help you

show information in a simple way.

ve

To add a table, go to the Insert tab
and click on the Table icon @ Y.
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You can choose the number of columns and rows for your table.
Columns run up and down and rows run left and right.

Let's create a table with 3 columns and 4 rows. Move your
mouse cursor across the first 3 squares and below the first four
rows and left click. A table with 3 columns and 4 rows wiill
appear in your document.
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live in” in the third column.

N—

The boxes in a table are called cells. You can add text in any
cell of your table by clicking the cell.

Try adding text to the cells of the first row. Type “Name” in
the first column, “Age” in the second column, and “City they

L P~ A == = =V | & v Fdv

Name Age City they live in

/Now try to select and bold the
top row.

Use the same steps you did to
select and bold lines of text

\ earlier.

Try filling in the rest of
the table with the
names, ages, and cities
of some of your family
members.

Name Age City they live in

( A
To delete a table, move your mouse over

the table until you see the table selection
icon |+ in the top left corner of the table.
Right click on it, then click on Delete Table.

If you're using a Mac, you can open the
right click menu by holding Control | control
on your keyboard and clicking on the table
selection icon |#+.

\ )

+:,}{j Cut

By Copy

Y

1

Insert

T3 Delete Table

Border Styles

AutoFit

References Mailings Review View Table Design

‘[y Paste Options:

H+t Distribute Rows Evenly

H Distribute Columns Evenly

City they live in

3

>

uﬁ Text Direction...
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Add page numbers

P
In the Insert tab, click on Page Number.

You can choose where to put the page number. You can choose to have it at the
top or bottom of the page. You can also choose whether the number is on the left,

right, or middle of the page.
Try adding page numbers to the bottom right of the page.

Simple

Plain Number 1

4

Tet Quick Wordi
Box~ Parts~

Plain Number 2

age r

jottom of Page 4
i‘ E‘J;i’: [.'1:.3”.',_ b Plain Number 3
|_" Current Position *

Save your document

.

To save your work, click on the Save icon )

A box will pop up. Type the name of your
document in the text box next to File Name.
Then select the folder where you'd like to save
the document. When you're done, click on
Save.

Layout

.

& This PC K -

File name:

Save as type:  Word Document (*.docx)

Tags: Add atag

[] Save Thumbnail

~ Hide Folders Tools - Cancel
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Review

Did everything make sense?

Is there anything you want to try again?

q [

Now let's see what you've learned

Do you think you can do
these things by yourself?

Not Yet

Bold, italicize, and underline text?

Change the font, size, and colour of text?

Add bullets?

Add hyperlinks, comments, and tables?

Save a document?

M ENERN
M ENERN

What do you want to do next?

C) [ ] Refresh, [ 11 understand it all,

let’s go over this lesson again let's go to the next lesson

17



